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Warranty and Software Licence Agreement 

WestDev Ltd and Number One Systems 

This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use of the 

Westdev and/or Number One Systems' products supplied with it. 

You agree to the terms of this agreement by the act of opening the sealed package which contains the storage media on 
which the software is recorded. Do not open the sealed package without first reading, understanding and agreeing the terms 

and conditions of this agreement. If you do not agree to the license conditions you may return the SOFTWARE for a full 

refund before opening the sealed package.  
1. LICENSE AGREEMENT 

Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts supplied by 

Westdev Ltd ("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby grants the Customer a 
non-exclusive license to use the LICENSED SOFTWARE on a single computer workstation. Each computer workstation, 

even on a network, must have its own separately LICENSED SOFTWARE. 

2. OWNERSHIP OF SOFTWARE 

As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE is 

originally or subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or the 

copyright owner retains title and ownership of the LICENSED SOFTWARE recorded on the original media and all 
subsequent copies of the SOFTWARE, regardless of the form or media in or on which the original and other copies may 

exist. This License is not a sale of the original SOFTWARE or any copy. 

3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the subject of 

copyright. Unauthorised copying of the LICENSED SOFTWARE, including software which has been modified, merged, or 

included with other software, or of the written materials is expressly forbidden. You may be held legally responsible for 
any copyright infringement which is caused or encouraged by your failure to abide by the terms of the License. 

4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is transferred 

with the LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this Agreement, and (iii) all 

complete or partial copies of the LICENSED SOFTWARE, including copies on data storage devices are also transferred (or 
destroyed). 

5. MODIFICATION 

You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, and you 
may not remove or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark notices. You must use 

all reasonable efforts to protect the LICENSED SOFTWARE, diskettes, and documentation from unauthorised use, 

reproduction, distribution or publication, or otherwise in violation of applicable law. Please contact our Customer Service 
department if you become aware of violations of Westdev Ltd's Copyright. 

6. TERMINATION 

The License is effective until terminated. You may terminate it at any time by destroying the LICENSED SOFTWARE and 
all complete or partial copies thereof. It will also terminate if you fail to comply with any term or condition of this 

Agreement. You agree upon such termination to destroy the LICENSED SOFTWARE and all complete or partial copies 

thereof. 
7. WARRANTIES 

No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, performance, 

accuracy or suitability for any purpose. In no circumstances will the copyright holder be liable for direct, indirect, 

incidental or consequential damages resulting from the use of this SOFTWARE. 

8. OTHER SOFTWARE 

The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall apply 
equally to this software except where the terms of this agreement are specifically modified by the copyright holder(s). Such 

modification(s) will be included in a machine readable file on the supplied disks. 

9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 

Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of copyright. 
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Chapter 1. Getting Started 

Installation 

Backing up your files 

If you already have Easy-PC installed, please remember to back up all your libraries, Technology 

files and any other data files before proceeding with the installation of the new version. The installer 

should not overwrite any of your own named files, but it can re-install new copies of our standard 

data files so if you have changed any of those files it is important to back them up first. If you are 

uncertain, check the time/date stamp on the file but in any case, make a back-up. 

Of course, backing up your data is important not only for the upgrade but also at regular intervals 

during design. 

Installation From A Download Link 

If you have been provided with download link, use this to download the installation executable, 

named EasyPC.exe. Find it in your Downloads folder using Windows Explorer and double-click it. 

You’ll need to type (or copy/paste) the password provided to unpack this file. Once the unpack 

password has been successful, you will be allowed to continue with the installation. 

All other instructions should be followed until you click Finish to complete the installation. 

The installation is the same for new and existing users alike. Existing users with versions prior to this 

latest version can install the new software over an existing installation without deleting the old one 

first. 

Installation From CD 

Installation is via the autorun setup. Insert the CD-ROM into your CD-ROM drive and wait a short 

time. The CD-ROM will run up to speed and an Easy-PC Welcome screen will appear. If autorun has 

been disabled on your computer you must execute the 'setup.exe' program using the Start menu and 

Run command from the Windows task bar. 

With the installer running, once the Welcome screen is displayed, double-click on the Install Easy-

PC - Version 22.0 option, or click then press Run. Following the instructions on the screen, you 

should use the same Destination Folder for the Program Files as your existing Easy-PC program 

files. 

All other instructions should be followed until you click Finish to complete the installation. 

Installing Over Existing Easy-PC Software 

If you already have an earlier version of Easy-PC installed on your system and you wish to install the 

new version into the same folder as the earlier one, please note that you will then end up with both 

versions listed in the Windows Control Panel list of installed applications.  

If you don’t want the earlier one to be listed in the Control Panel, you will need to un-install that 

version before you install the new one. If you install the new software into the same folder as the old 

version then try to un-install the old one, you will find that the new software will not run as the un-

install will have removed many or all of the program files. 

If you wish to install and use the new version without removing the old one, you will need to install 

the new version into a different folder. The two versions will then operate independently and either 

can be un-installed without preventing the other from running. 
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Data Files Location 

There is a step in the Setup installation wizard that asks you where you want to place data files (for 

example, Libraries, Technology files, etc). The default is always to use the common documents 

folder, “Users\Public\Documents\Easy-PC” on Windows 7, 8 or 10 (or the local language 

equivalents) if you are installing for All Users, or into your own Documents folder if installing for 

current user only. 

Running Easy-PC 22.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, or the Start 

pane if using Windows 10, you may also wish to create an Easy-PC Shortcut icon on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems folder or the 

Start pane if using Windows 10. 
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Chapter 2. New Features in Easy-PC V22 

Introduction 

All features are categorised as being applicable for either products (unmarked), or (SCM) specific or 

(PCB) specific. 

Library Integration with the Component Search Engine 

Easy-PC Version 22 will be delivered with free access to the Component Search Engine.  

The Component Search Engine web site enables you to search Components (along with Schematic 

and PCB Symbols) and download them to your Easy-PC application ready to use. Not only do they 

appear on the end of your cursor but are also automatically added to your library to use on another 

design. 

Product Version/Build Requirements 

You will need to be running Easy-PC 22.0 to benefit from the Component Search Engine 

integration. This feature will only ever run on the latest major version of Easy-PC. 

Registering with Component Search Engine 

To use the Component Search Engine, you will first need to register an account. 

Go here - https://easypc.componentsearchengine.com/ and click Register. 

 

On the Tools page, scroll down to the Library Loader section. 

 

Click the Download Library Loader button to start the download. 

https://easypc.componentsearchengine.com/
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Once downloaded, run the LibraryLoaderSetup.msi program from your download folder.  

 

Once the Library Loader has been successfully installed, open the Library Loader from your 

Windows Start menu. 

You will be asked to either Register or Login. As you have already registered you can select the 

Login Tab and Login using your User Name and Password.  

 

Once logged in, select Your ECAD Tool as Easy-PC using the drop-down list box. Now select the 

Settings button next to it. 

From within the Settings dialog you will now be able to set the destination for where new Schematic 

Symbols, PCB Symbols and Components will be saved to. 

 

 

Now you’ve set up the Library Loader you can now download Components from the Easy-PC 

Component Search Engine web site and they will load directly into your libraries and onto the end of 

your cursor ready for placement in a design.  

Using the Easy-PC Component Search Engine 

From the Easy-PC Component Search Engine website  

(https://easypc.componentsearchengine.com/), enter the name of your Component or a description of 

https://easypc.componentsearchengine.com/
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it in the Search section. Once the search is complete you will see six columns presented including an 

ECAD Model, Datasheet and Pricing/Stock information for the Component from various suppliers. 

Clicking the Price/Stock link will allow you to select and download the Part with pre-populated 

attributes from a specific supplier.  

 

Clicking the Download ECAD Model button will download the model from the website into your 

libraries and onto the end of your cursor ready for placement in the design. Attributes are 

automatically added to the Part depending on the section you download it from, therefore if we click 

Download ECAD model from RS Components, we would then also see the RS Part Number on the 

Part in Easy-PC.  

 

Now the Component has been downloaded, you can investigate its values from the Edit Component 

dialog in Easy-PC under the Library Manager to see it has inherited the values from the online 

model, including the Supplier name and Supplier Part number.  

 

Updating Imported Parts to Company Standards 

It is always worth remembering that imported parts may need to be updated to your company 

standards. For example, this may mean adding attributes to Components or changing text, pin and line 

styles on Symbols and Footprints to be in-line with your other library items. 
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Closing the Library Loader Application 

As the Library Loader will run in the background, you will need to close the background application 

if you wish to close it completely. To do this, select the up arrow on your taskbar, select the 

Library Loader icon and from the menu displayed, click Exit.   

 

 

Supported Web Browsers 

The following browsers are support by the Component Search engine integration: 

• Google Chrome 

• Mozilla Firefox  

• Microsoft Edge  

• Apple Safari 

Note: Internet Explorer is not supported for the full integrated searching and download capability.  

 

Associated Parts 

There is a new type of Library item introduced for version 22 called an Associated Part. This is used 

when a component requires additional items to be provided on the Bill Of Materials (BOM) but where 

you do not wish them to physically appear in the design. The additional items attached to a TO-220 

transistor for example, would need to include the heatsink, nut, bolt, nylon washer and thermal paste. 

 

There are a number of mechanisms for associating a Part with a Component; create a new list of 

Associated Parts in their own library and add these to the Component that requires it, or add an 

Associated Part by typing in its details on the fly when editing a Component. The advantage of using 
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an Associated Part from a library is that it will be more consistent and can be used again for multiple 

Components. You can also add Associated Part information to a Component in the design using its 

Properties or you can add design-level Associated Parts, these might be a ‘higher’ level than a 

Component, for the board construction for example, like specifying FR4 or a board part number. 

Associated Parts and Libraries 

For library items, a new tab for Associated Parts has been added to the Library Manager dialog: 

 

Once an Associated Parts library and Associated Parts library item have been created, this item 

can then be added to a Component using the Associated Part tab on the Component Editor dialog: 
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Creating New Associated Parts Libraries and Items 

From the Associated Parts tab in the Library Manager select the New Item button: 

 

 

All information on this dialog is saved with the Associated Part and ‘attached to the Component once 

associated. 

Adding Associated Parts items to Components in the Library 

From the Associated Parts tab of the Component Editor, use the Add button. 

 

This opens the Add Associated Part dialog: 
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From here, you can add an Associated Part from an Associated Parts library, or you can type in the 

details directly. Either way is fine, however, if you wish to use the same Associated Part again, saving 

it into a library might save you time later on. It might also be more efficient for consistency too. 

Adding Associated Parts items to Components in the Design 

For a design that does not have Associated Part, these can be added using the Component Properties 

dialog and Associated Parts tab. 

 

Use the Add button to add Associated Parts to the list. 
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Adding Design-Level Associated Parts 

Associated Parts can be added to the design, for items such as the PCB itself, board mounts etc. 

To add these, use design Properties from the View menu. 

 

Easy-PC knows and reports the difference between Component Associated Parts and design-level 

Associated Parts. 

Associated Parts 

Once Associated Parts have been included in a design, they will appear as a separate section for 

Associated Parts in the BOM Composer report. 

 

Using Associated Parts in the design 

Other features within Easy-PC also understand how to handle the new Associated Parts: 

Translate to PCB – Components added to the PCB will have instance-level Associated Parts copied 

from the Schematic. 

Update Component – when updating the design from the library, a new check box exists to Keep 

Associated Parts. 
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Duplicate/Copy/Paste – any Associated Parts defined on Component instances will also be copied 

across to the new Component. 

Value Properties in Component Editor 

For the Properties page in the Component Editor, you can now set the display of Values at the 

Component library level. 

 

Changes to Plotting and Printing Dialog 

Reports in Plotting 

The ability to specify Reports when generating a ‘set’ of plots has been added to the Plotting and 

Printing dialog. 

From within the Add Plot dialog, using the new Report button, you can now choose the report you 

wish to run when generating plots.  
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Selecting the Report button takes you to a version of the Report Manager dialog from where you 

select which report you want to run. The list includes built-in reports, user-defined reports and BOM 

composer outputs. 

 

Once selected. The report appears in the main Plotting and Printing dialog. This setting is also saved 

into the Plot Job using Save Job. 
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IDF and DXF in Plotting 

You can now create plots that generate DXF and IDF outputs as part of the Plotting and Printing 

mechanism. This includes saving all the relevant settings from the IDF and DXF dialogs into a Plot 

Job for easy production of different outputs. 

 

When either of these options is selected, it will simply add a plot into your plot list. Any settings 

defined in the DXF or IDF options from the Output menu will be used. 

 

Note: IDF Export is a cost option feature and will only appear on this dialog if you have purchased it 

and if it is enabled from Settings, Optional Features. 
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Plotting Layers – Select/Deselect All 

There are new buttons for Select All and Deselect All on the Layers tab of the settings for a plot. Use 

these to quickly make selections. 

 

Output Plots to Zip file 

There are two new check boxes on the Options dialog of the Plotting dialog. This allows you to 

automatically save the generated output files (Gerber, NC Drill, Reports, etc.) directly into a Zip file, 

and optionally remove the individual files afterwards. 

 

Pack output files into a Zip – output files are exported as normal, then saved into a Zip file. Without 

the Remove check (see below) selected, all the files will remain saved on your hard drive along with 

the Zip file also. The Zip file will be named DesignName -.zip following your file name pattern for 

plots. 

Remove individual files after Zipping – if the check box to Zip the output files has been selected, 

selecting this option will then remove them from your hard drive. All plots will be removed and just 

the Zip file (containing the plots and reports) plus the Plot Report will remain. 
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Customisation of Plotting File and Folder Names 

Version 22 introduces user-defined formatting of Folder and File names in the Options dialog of 

Plotting and Printing. This uses a ‘tag’ scheme with user-defined key words to format the output 

filename. This applies to the folder name when the folder is set to ‘this folder below design’, and to 

file names for each plot. 

Tags can include Design Name, Plot, Plot Job and Project Name, Device Type, etc. To help you 

construct the tag pattern, syntax and creation, there is a new Compose dialog. 

Where patterns are used 
These patterns are used to construct the folder name for storing plots and other files generated during 

Plotting and Printing, and also to construct the actual names for these files. This allows you to apply 

some quite sophisticated rules to name and organise your output files. 

When composing the pattern for the output folder, the default value is simply the text "Plots" which 

will place the output files in the Plots folder below the design file.  

When composing the pattern for actual output files, the default value combines the design name, the 

plot name, and (if variants are used) the variant name.  

You can use the controls on this dialog to alter the pattern to suit your preferences. 

From the Options dialog, a defined pattern is displayed: 

 

By selecting the Compose button, this reveals the Compose File Name Pattern dialog. From here, 

you can make choices that will customise your output filenames. 
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The File Name Pattern box on the dialog shows you the current pattern. These patterns are made up 

of 'tags' or 'fields' that are replaced at runtime with the relevant values, as well as any text required to 

complete the name. 

Example Name: will display a preview that will show you what the final composed name might look 

like when the current pattern is applied. This will help you to quickly see the results of manipulating 

the pattern by altering the text or adding or removing elements.  

Click on any of the buttons in the Insert Elements area to add the relevant item to the pattern at the 

current location of the text cursor. 

When you click any function button that is not a text character, you will see the relevant tag added to 

the pattern. The 'character' buttons are there for convenience to simply save you typing the character 

yourself. They do not form part of the element but are used for filename formatting. 

As well as design elements, you can also choose to add a Value to the pattern. The drop down list will 

provide you with all the value names defined in your design. Not only does this give you system 

values but also component values should you so wish to use them. 

To remove elements from the pattern, click within the tag on the pattern box, then click the Select 

Element button. The text for that tag will become selected, and you can then either click one of the 

Insert buttons to replace that tag with the one you really want, or click Delete Selected to remove it 

from the pattern. 

You can also edit the pattern by hand, to insert, alter or remove plain text items. 
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Gerber Output File Extensions for Board Outline 

When setting up custom file extensions for Gerber files (through Plotting & Printing, Device Setup, 

Gerber Setup, Setup, Gerber File Extensions), an extra setting on the dialog allows you to specify the 

file extension for a plot containing the pseudo-layer [Board Outline]. 

 

Plotting - Auto Mask 

The ability to automatically create mask (solder resist/paste) for Copper Shapes attached and 

associated to pads in PCB Symbols has been extended to work on user-created mask layers in the 

PCB (layers which use a layer type which has a defined over or under-size). Any shape defined on a 

copper layer as part of a symbol will now create an appropriate under or oversized shape on an auto-

mask layer. Previously, the Auto Mask facility was only available for pads-only plots generated at the 

Plotting stage. 

IDF Export Dialog Changes 

When using the IDF Export cost option, there is an extra check box to Always output to same 

folder. File names will default to the name of the design, but with this check box selected then once 

you have chosen a folder for your output files that folder will override the design folder next time you 

open the dialog.  
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This will be useful for users using SolidWorks which likes to import only from one specific folder. 

 

DXF Export Dialog Changes 

There is an extra button to Deselect (uncheck) all the layers in the list. Initial default layer selection 

will check those layers that are currently used (have data present) in the design. 

 

Create BOM Composer Reports from Reports Dialog 

The Report Manager dialog when selected from Outputs menu now lists saved BOM Composer 

Reports. This means you can generate BOM Composer Reports from the same dialog as all the other 

reports. 
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Component Bin – Highlight Nets 

Within the PCB Design editor, Components which are attached to the currently highlighted net are 

highlighted in the Component Bin by underlining them with a coloured bar. If the net is large, such 

as for a GND signal, then it may be possible that multiple components are highlighted with the 

underline. 

 

This option can be enabled in the Preferences dialog under Display. The underline colour for 

Highlight Nets in Component Bin can also be chosen here. 
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Colours (PCB) – Display of Poured Shapes 

There is now a separate column in the Display (colours) dialog for Poured Shapes allowing them to 

have different colour and visibility settings from other shapes. 

 

Layers Bar – Additional Check Boxes 

Additional check boxes to separate Shapes, Poured Shapes and Symbol Shapes have been added to 

the Layers Bar. 

A new set of check boxes alongside the existing ones have been added to toggle the state of True 

width settings. 

 

Auto Mirror Component Setting in Component Editor 

From within the Component Editor dialog in the Library Manager, on the Properties tab, a new 

setting, Auto Mirror on add to PCB has been added. When checked, when this component is added 

to a PCB design (through the normal mechanisms - Add Component, Translate to PCB etc.), it will be 

flipped (mirrored) to the other side of the board automatically. 

 



26   Easy-PC V22.0 Supplement 

Inserted Files and Reports into a Design 

Two new features, Insert File and Insert Report, are available on the Add menu for both Schematic 

and PCB designs. 

Add – Insert File 

From the Add menu, you can use Insert File to insert the contents of an existing text file into the 

design as a visible item. This is similar to what you can already do by pasting in the text of the file 

into a free text item, except that this new item retains the link to the underlying file and can reload it 

into the design. 

Once the required file has been selected using the standard Open dialog, the Add Inserted File dialog 

is displayed: 

 

This allows you add additional detail to the file, such as a Border, and to Reload it before plotting to 

ensure it is up to date. 

Relative to design : check this box to specify that the application should look for the file relative to 

the location of the design file if the file is reloaded in the future. With this box unchecked, the 

application will always use the full absolute path of the file you selected.  

Reload before plotting : check this box to tell the application that the file should be re-loaded and the 

inserted table re-generated whenever plots are run in the Plotting and Printing dialog.  

Border : check this box to add a border (box) around the outside of the text.  

Change settings if you wish, and press OK. The contents of the selected file will be read in, and a 

visible item built from free text with an enclosing border (if selected) will appear on the cursor for 

you to place. This will now act as one complete ‘unit’. 

Add – Insert Report 

A similar command is also available that allows you to Insert Reports as visible items in the design. 

You can insert most built-in reports and user-defined (both custom and BOM Composer) reports. 

When this option is selected, the standard Reports dialog is displayed from which to make the report 

selection. 

Properties of Inserted Files/Reports 

Corresponding commands exist to update the inserted files using the context menu for a selected 

report: 
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A Properties tabs for selected inserted reports provides access to the settings. 

 

DRC Dialog Changes 

Dialog Layout 

New checks have been added to the Design Rules Checking dialog and the Manufacturing section of 

the dialog has been split as well as sorting it alphabetically. 
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Acid Trap Check 

Acid Traps: This checks for acid traps between Track segments and between Tracks and Pads.  

An acid trap is considered to be an acute angle created between design items, usually tracks and pads 

(as shown below). 

  

There are two new settings on Rules tab of the Design Technology page to set up the angle and gap. 

 

Minimum Allowed Angle is defined between track segments or between the edge of a track segment 

and the pad shape it exits from. An angle of 0 disables this check. An angle greater than 90 degrees 

will only apply to track segments and not the exit angle from a pad.  

As well as the detection of acute angles (less than the Minimum Allowed Angle defined), the angle 

also represents calculated angles based on tracks closer than the gap between the pad and the 

offending segment. This is defined as the Minimum Allowed Gap. 
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Minimum Allowed Gap is the gap between a pad and a track segment after the previous segment has 

exited the pad. If this second segment had turned to below the Maximum Allowed Angle relative to 

the edge of the pad, then an acid trap has been formed. Setting a gap of 0 disables this check. 

Component Names Check 

Component Names: checks for component names that are closer to a component other than the one 

to which they really belong. This is to avoid misunderstanding when the silk screen looks like the 

name belongs to the wrong component. 

Stub Vias Check 

Stub Vias: Checks for track segments which end on a via that does not appear to be connected to a 

Pour Area or plane. This aids the verification of the overall signal integrity to ensure no ‘gaps’ appear 

in the electrical path. 

Minimum Allowed Gap 

Minimum Allowed Angle 
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Test Land Check 

Test Land: DRC checks are available for minimum separation, minimum land size, under 

components and unreachable side.  

There are new settings on the Rules tab of the Design Technology page where you can set up the 

Minimum Size and Minimum Separation, and the Probe Side (top, bottom, either or both).  

 

Test Land Separation - Checks to see if you have any items (pads or vias) marked as Test Lands that 

are closer together than the distance specified (Minimum Separation) in the Rules tab of the Design 

Technology page.  

Test Land Width - Looks for items marked as Test Lands that are smaller than the defined 

Minimum (Test Land) Pad Width in the Rules tab of the Design Technology page.  

Test Land Under Component - Looks for Test Lands that could be obscured by the body of a 

component and could thus be inaccessible to test probes.  

Test Land Unreachable - Looks for Test Lands which don't exist on a layer selected as a valid 

Probe Side in the Rules tab of the Design Technology page.  

Min Annular Ring Check 

There is a new subsidiary check box for Min Annular Ring check within the DRC dialog to check 

Only Where Track Exists. This will flag annular ring errors only on pads/vias where there is a track 

connected on a layer where the annular ring is too small. In other words, it will not report errors for 

undersized rings when there is no track trying to connect to the ring. 
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Min Hole Size and Min Via Annular Ring Checks 

A new check for Min Hole Size has been added to the Design Rules Check dialog. 

The existing check for Min Annular Ring has been expanded with new rules available under this 

check for checking the minimum ring size of Vias. 

All the above new checks have a rule entry on the Rules page of the Design Technology. 
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View Menu - True Width and Visibility On/Off 

There are four new commands available from the Side submenu of the View menu to toggle all True 

Width and Displayed (Visibility) On or Off. 

 

Add Teardrops – Add DRC Error Markers When Cannot Be Added 

There is a new check box on Apply Teardrops dialog to Add DRC markers when Teardrop will 

not fit. This flags up places where the application cannot insert the required teardrop because it is not 

legal (due to shortness of track segment, pad too small, too close to other items, etc.). 

 

Display (Colours) for ‘Composite’ Items 

Within the Display (colours) dialog under Settings and Highlights, the ability has been added to 

actually show or hide ‘composite’ items, such as Dimensions, Text Callouts, and Inserted Tables 

(Drill table, Layer Stacks, etc.), rather than simply altering their colour by highlighting them. 



 Easy-PC V22.0 Supplement   33 

 

HTML Report Setting in Preferences 

An extra check box has been added to the Preferences dialog and General page, allowing you to 

suppress the text version of HTML reports – suppress Text Reports. Previously, if you enabled 

HTML reports, you would also get the same report in TXT format alongside every HTM file. 

 

Proportional Text Styles for System Font 

From within the Design Technology dialog and Text Styles page, text styles that use the <System 

Stroke Font> can now be set as Proportional. In addition, you can modify the percentage 

character width (to create ‘compressed’ text) and the line spacing (to squeeze up or spread out 

multi-line text). 

As well as the Text Styles page of the Design Technology dialog, these changes also affect Change 

Text Style and the Text Properties dialog. 
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The three examples below show how the new settings affect the character spacing and line spacing. 

All three examples have the same Width and Line Width: 

 

Normal: 

Char % 100 

Line % 120 

 

 

Char % 100 

Line % 80 

 

 

Char % 75 

Line % 120 

Properties - Text Alignment 

Text Properties alignment is now 3 radio buttons in place of the drop-down list for quicker access to 

the alignment setting. 
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Text Alignment Changes 

Three new commands have been added to the context menu for selected text. This enables you to set 

all text items of current selection as either Left, Centre or Right justified. 

 

New Library option on Library Wizards 

On the Finish page of the three library item Wizards (Schematic Symbol Wizard, PCB Symbol 

Wizard and Component Wizard), you can now select the [New Library] option from the drop down 

list as a choice of libraries to specify a new library file in which your new item is to be saved. When 

run, this will prompt you for the name and location of the new library. 
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Goto Bar Changes 

Typed Names in Edit Box 

The Goto Bar now has edit box where you can type in the name of the item you are looking for, 

rather than being purely a list box of items of the chosen type. The speeds up your search process in 

long lists where you know all or part of the name of the item you need to find and where it is at the 

bottom of the list, X1 or U22 for example! 

 

Copper Pour Areas Details 

When listing Copper Pour areas in the Goto bar, they are now listed with details of their Net Name, 

Layer Name and Pour Order (previously they were all listed/grouped only by Net). If you have the 

Goto Bar displayed (locked out) and you make changes to the Copper Pour areas items in the design, 

you must use the Refresh Find List from the context menu (right clicking in the Goto Bar) to update 

it. 

 

 


